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EndNote Web 
Class Outline 

1 Overview 

1.1 Functions of EndNote Web 

1.1.1 Bibliography Creation 

EndNote Web works with your word processor to create formatted bibliographies according to 

thousands of styles. 

1.1.2 Reference Organization & Sharing 

EndNote Web tracks your references online in your personal, password-protected library. You 

can access your library anywhere there is Internet access and share references with other 

EndNote Web users. 

1.1.3 Connectivity 

EndNote Web includes three different ways to import references from online databases— 

 Online Search allows you to search online databases from within EndNote Web. 

 Direct Export downloads references directly from online databases into EndNote Web. 

 Importing Text Files allows importing of text files saved from online database searches. 

EndNote Web also provides seamless transfers between your EndNote and EndNote Web 

libraries. 

1.2 EndNote Web System Requirements 

1.2.1 Web Browser 

 Microsoft Internet Explorer 7.x–9.x
*
 

 Firefox 

 Safari 4.x, 5.0* 

1.2.2 Windows Plug-in Requirements 

 Microsoft Windows XP SP2 or later / Windows Vista / Windows 7 

 Microsoft Word 2003 / 2007 / 2010 

 Microsoft Internet Explorer 7.x–9.x
*
 with the latest service pack set as the default Web 

browser 

 Firefox for Windows set as the default Web browser 

1.2.3 Macintosh Plug-in Requirements 

 Macintosh OS X 10.5.x through 10.7.x 

 Microsoft Word 2008/2011 

 Firefox for Macintosh set as the default browser 

                                                 
*
 Cookies and JavaScript must be enabled in the Web browser settings. 
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1.3 Word Processor Compatibility 

1.3.1 Windows 

 Cite While You Write — Microsoft Word 2003 / 2007 / 2010 

 The Format Paper feature works with any word processor capable of producing rich text 

format (RTF) documents. 

1.3.2 Macintosh 

 Cite While You Write — Microsoft Word 2008/2011 

 The Format Paper feature works with any word processor capable of producing rich text 
format (RTF) documents. 

1.4 General Statistics 

 Store up to 10,000 references (25,0000 references with file attachments for EndNote X5 
users or 50,000 references for EndNote X6 user) 

 Create and share up to 5,000 personal groups 

 3 ResearcherID groups (if you also have a ResearcherID account) 
References in your ResearcherID groups count towards the 10,000, 25,000, or 50,000 

total per library reference limits 

 48 predefined reference types 

2 Register for an EndNote Web Account 

To use EndNote Web you need to register for an account.  Your account name will be your 

e-mail address.  Please use a permanent address.  This address will be used to send you 

important information about your account.  You will also need to create a strong password 

including at least one number and one symbol, and it must be at least 8 characters long. 

2.1 Institutional Access to EndNote Web and Roaming 

If your institution has a site license for EndNote or the Web of Knowledge, you can register at 

either www.myendnoteweb.com or through the Web of Knowledge site.  You will need to be 

onsite to register, but after registering you will have “roaming” access, allowing you to access 

your EndNote Web library from any location with Internet access. You can roam for twelve 

months before you need to log in from your institution. The “Account Information” option under 

the Options tab will tell you how many days are remaining in your roaming access. 

If you have already created a personalized Web of Knowledge profile, use the logon for that; you 

do not need to create a new account. 

    

2.2 EndNote Web from an EndNote Purchase 

If you are using EndNote, you can also register through the EndNote Web section of your 

EndNote preferences, or during your first synchronization in EndNote X6.  EndNote X5 and 

X6 users must register a new EndNote Web account or “link” an existing EndNote Web account 

to their EndNote installation in order to get the premium features of increased record numbers 

and attachments available with those versions of EndNote. 

    

    

http://www.myendnoteweb.com/
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3 The My References Tab—Your “Home Base” for Working in 
EndNote Web 

The My References tab displays the contents of your EndNote Web library.  From here you can 

view the complete list of references, or only the references in a single group.  If other EndNote 

Web users have shared groups with you, these can also be displayed on the My References tab. 

The Quick Search feature is also accessed on this tab, allowing you to search your entire 

EndNote Web library, or just a single group. 

As you add references to your library and organize them into groups, you will see the results 

shown here, on the My References tab.  

    

    

4 Collecting References—The Collect Tab 

References can enter your EndNote Web library in several ways. 

1. References can be transferred from an EndNote library (EndNote X.0.2-X5) or 

synchronized with an EndNote Library (EndNote X6) 

2. References can be exported from the traveling library contained in Word documents 

3. References can be exported directly from some online databases, such as the Web of 

Science, using Direct Export 

4. Some online databases can be searched from within EndNote Web and the search results 

transferred to the EndNote Web library 

5. References can be saved as text files and then imported into EndNote Web 

6. References can be manually typed into EndNote Web records 

Numbers 1–3 will be dealt with below.  Numbers 4–6 can be accessed through the Collect tab. 

    

    

    

4.1 Synchronization (EndNote X6) 

EndNote X6 can synchronize up to 50,000 references and 5,000 groups between an EndNote 

desktop and Web library, including up to 5 gigabytes of attachments.  References can also be 

synchronized to a second desktop computer and/or an EndNote iPad library (EndNote for the 

iPad will be released in late 2012).  For the first synchronization on any device, there are 

several important considerations. 

1. For the first synchronization on any device, ALL references and groups will be copied in 

both directions.  This will result in duplicates if the same references reside on the device 

and EndNote Web. 

2. References and groups will be synchronized, but group sets, smart groups, and combined 

groups (groups from groups) will not be synchronized.  Therefore, if two groups in an 

EndNote library have the same name, but are under different group sets, they will have 

the same name in EndNote Web, but will have no group set to distinguish them.  

Consider renaming groups of the same name to more easily tell them apart in EndNote 

Web before your first synchronization. 
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3. Only one EndNote library on a device and one EndNote Web account can be 

synchronized, so it is best to keep all your references in one library and use groups to 

categorize them. 

4. Make a backup copy of your EndNote desktop library before your first 

synchronization by selecting Compressed Library from the File menu.  This provides 

a backup in case you have problems.  EndNote will prompt you to do this, but this 

command can be used to create a backup of your library at any time.  This backup will 

have a .enlx extension.  Any compressed library created after your first synchronization 

will contain synchronization information. 

5. If you delete references or attachments from one library, they will be deleted from the 

other synchronized libraries with the next synchronization. 

6. Synchronization will always be of the complete library until your record or attachment 

size limits are reached.  There is no selective synchronization. 

7. If you synchronize to a second device, all groups will appear under an Unfiled Groups 

group set.  You will need to recreate your structure of group sets, smart groups, and 

combined groups on the second device, then drag your groups from the Unfiled Groups 

group set to their correct location.  After recreating your group set structure, the groups 

and references will synchronize automatically in the new locations. 

See our video Synchronizing EndNote Desktop and Web Libraries at 

http://www.youtube.com/watch?v=-taoGlhRY7k for more information.   

    

    

    

    

4.2 Transfer from EndNote (EndNote X.0.2–X5) 

You will be presented with a window where you can select which direction you wish to transfer 

your references, either from EndNote Desktop to EndNote Web, or EndNote Web to EndNote 

Desktop.  You can also select specific groups for transfer. The Transfer feature is not available 

in EndNote X6. 

The transfer feature copies references, it does not synchronize references.   

    

    

4.2.1 Transferring File Attachments with EndNote X5 

By default EndNote X5 will also transfer files and figures attached to records.  This option can 

be deselected.  When transferring references with attachments, all new attachments are 

transferred in both directions regardless of the selected transfer direction. That is, attachments 

are added to both sides during a transfer even though the transfer occurs in one direction. 

Points to consider: 

 If you delete an attachment from a reference in EndNote desktop, then you must 
manually delete that attachment from the reference in EndNote Web and vice-versa if 

you wish to keep the two references in sync. 

http://www.youtube.com/watch?v=-taoGlhRY7k
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 EndNote Web has no limit on the number of file attachments per reference. When 
transferring references with attachments from EndNote Web to EndNote desktop, all 

attachments are transferred to the desktop, even if this number exceeds the 45 file 

attachment limit in EndNote. 

    

    

4.3 Exporting References from the Traveling Library 

Please see the section 8.7 on exporting references from the traveling library later in this outline. 

4.4 Direct Export 

Direct Export provides a quick and easy way to transfer data from online databases that support 

it.  Direct Export requires the EndNote Web plug-in for Internet Explorer or Firefox. 

4.4.1 Thomson Reuters Web of Knowledge (with and without the Plug-in) 

 After obtaining your results in the Web of Knowledge, select the references you want to 

export to EndNote Web, then select the EndNote Web button (if you do not have the 

plug-in installed) or the EndNote button to save your references. 

 The references you selected will be imported into the Unfiled folder in your EndNote 
Web library. 

If you are simultaneously logged on to both the Web of Knowledge and EndNote Web, 

references that were imported from the Web of Knowledge will show links between the two. 

    

    

    

4.4.2 Other Databases—Using Internet Explorer Plug-in 

Direct Export with the Internet Explorer plug-in for Windows will give you an option of 

importing references from many online databases into either your EndNote or EndNote Web 

library during the import process.   

    

    

4.4.3 Other Databases—Using Firefox Plug-in 

Direct Export with the Firefox plug-in works on both Windows and Macintosh computers and 

allows you to import references from many online databases into EndNote Web.  Note that this 

option does not give you a choice between downloading to EndNote or EndNote Web during 

each import process as the plug-in for Internet Explorer does.  However, you can set in your 

Firefox options whether you wish to import to EndNote Web or into EndNote.  Importing into 

an EndNote library requires separate setup.   
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4.5 Online Search 

The default option when you click on the Collect tab is Online Search.  This option allows you 

to search online databases from within EndNote Web.  With the exception of the PubMed and 

Web of Knowledge databases, this feature is limited to searching databases using the z39.50 

Internet protocol.  This is a special protocol designed for the search and retrieval of 

bibliographic data.  Because of this special protocol, there are limitations in how this feature 

works with firewalls and proxy servers.  In general you will be able to search public access 

databases such as university book catalogs, large public library catalogs, and national catalogs 

such as the Library of Congress without problems.  However, subscription catalogs that require 

IP authentication will not work because this protocol does not work as your browser does and 

will not be able to send an authentication through a proxy server.  You will still be able to 

access these databases and import the references into EndNote Web using one of the other 

methods of importing. 

 To begin an Online Search, select the drop-down menu above the Connect button.  You 
will see a list of available online catalogs.  Please note that EndNote Web administrators 

for your site can control which online catalogs are displayed on this list, so the list may 

vary in length.  If you see more options that you want to work with, you can customize 

this list by selecting the Customize this list link.  After you customize your list, only the 

ones on your custom list will be available in the drop-down list. 

 Select the catalog you wish and click on the Connect button. 

 You will be presented with a search window where you can enter your search criteria, 

then click on the Search button to perform the search. 

 EndNote Web will report how many references were found.  Click on the Retrieve 
button to retrieve the references. 

 The references will appear in the Online Search Results list. 

 Mark the references to copy to your personal EndNote Web library, then select the group 

they will be added to from the drop-down list.  The marked references will be added to 

that group and can then be viewed on the My References tab. 

    

    

    

4.6 Import References 

4.6.1 Saving Data from Online Databases 

All importing uses a pattern matching process where the pattern of the tags in the data is matched 

against the pattern of the tags in the import filter.  It is very important that data be saved in the 

tagged format that matches the filter that will be used to import it.  Below is an example of 

tagged text.  The tags are on the left and the data follows them. 

 TI  - The Scale and the Feather:  A Suggested Evolution 

 AU  - Rex, Tiberius 

Instructions on how to save the data will vary depending on the database provider.  You can 

find instructions for many different database providers in the EndNote Web Help files. 

 Select the Help link in the upper right corner of the EndNote Web screen. 
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 Click on the Import Formats link under the Collect Heading. 
This will display a table with instructions for saving the data from different providers so 

that it will match the EndNote Web filters. 

 Locate the database provider for your data on this list.  You can usually find the 

database provider’s name on the web page you are searching, often in a page header. 

 Save (download) the data according to the instructions in the table.  It is best to save the 
data somewhere you will easily remember, like your desktop. 

 Return to your EndNote Web library to import the data. 

    

    

    

4.6.2 Importing the Saved Data 

 On the EndNote Web Collect tab, select the Import References option. 

 Click on the Browse button to select the data file you saved (downloaded). 

 Locate the file you saved.  EndNote Web may not always display the download 
location, but will display a standard Windows dialog where you can locate it. 

 Select the matching filter from the Import Option drop-down list of available filters.  If 
you do not want to see the complete list, you can customize this list just as you did the list 

in Online Search. 

 Select the group you want to import into from the To drop-down list. 

 Click on the Import button.  Your saved references will be imported into the group you 
chose, and you can view them using the My References tab. 

    

    

    

4.7 The Capture Button and Bookmarklet 

The Capture button on the Internet Explorer or Firefox toolbars for EndNote Web can be used to 

import data from the Web that is not within bibliographic databases, such as book information 

from Amazon.com or video information from YouTube videos.  Please note that it will 

generally not import all the information, so you will need to add the rest manually. 

The Internet Explorer plug-in may require administrator access to install on your computer.  If 

you are unable to install it, you can still use the Capture button by installing the Capture 

bookmarklet.  You can find the Capture bookmarklet in the Download Installers section on the 

Options tab.  

Some databases will allow you to capture multiple records while others may only allow you to 

capture one record at a time.  
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4.8 New Reference 

Unfortunately, not all references can be imported from online databases, so you may 

occasionally need to enter a reference manually.  You can do this by selecting the New 

Reference option on the Collect tab. 

The reference type you select will determine which fields are available in the data entry screen.  

Some fields have special properties and must have information entered in special ways. 

 Personal author and editor names should be entered in the format Last Name, First Name 
and each name should be entered on a new line.  So John Smith and Peter Jones would 

be entered as— 

Smith, John 

Jones, Peter 

 For corporate names, put a comma at the end of the entire name.  So the University of 

California would be entered as— 

University of California, 

 The Year field should have all four digits of the year. 

 Keywords must be entered on a new line within the Keywords field. 

 File Attachments: You can attach up to 5 files at a time, but there is no limit to the total 
number of file attachments per record.  There is no restriction to the size of a file 

attachment; however, the total amount of space allotted to file attachments depends on 

your version of EndNote. 

 Figure Attachments: You can attach only one figure per record.  There is no restriction 

to the size of a figure attachment, but figure attachments do count towards the 

attachments limits for your account. 

At the bottom of the data entry screen you can select the groups you wish to add this reference 

to. 

Reference data will be saved automatically as you type. 

    

    

5 The Organize Tab 

This is where you can organize your library into groups, share your groups with other EndNote 

Web users, and configure how groups other users have shared with you will be displayed and 

used. 

5.1 Manage My Groups 

The Manage My Groups option will let you create up to 5000 groups within your EndNote Web 

library and share them with others. 

 Select New Group to create a new group. 

 Mark the Share box to share that group with other EndNote Web users, then select 

Manage Sharing for the group.  You will need to enter the EndNote Web e-mail address 

for each user’s account you want to add.  File attachments are not shared: only the 

owner of the group will see file attachments. 

 Select Rename to change the name of one of your groups. 
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 Select Delete to delete a group. 

    

    

5.2 Others’ Groups 

Just as you can share your groups with other EndNote Web users, they can share their groups 

with you.  However, you may not wish to see all of their groups.  Here you can select which 

groups others have shared will be displayed on the My References tab.  You can change these 

options at any time.  You can also select which groups others have shared that you wish to use 

with Cite While You Write in your Word documents. 

    

    

5.3 Find Duplicates 

The find duplicates option will search your EndNote Web library for duplicates and 

automatically mark the duplicate references.  EndNote Web will consider a reference a 

duplicate if the authors, title, year, and reference type are the same. 

Duplicates can be added to your Quick List or a group of your choice, or deleted, in this screen. 

    

    

5.4 Manage Attachments 

This option displays a list of all file and figure attachments. 

    

    

6 The Format Tab 

Here you can create independent bibliographies, format papers using word processors other than 

Microsoft Word, download the Microsoft Word plug-ins, and export references so they can be 

imported into other database or bibliographic software programs. 

6.1 Bibliography (Optional) 

This option allows you to create independent bibliographies according to the style of your 

choice. 

 Bibliographies can be created from a single group, all the references in your library, the 
references in your Quick List, or from groups others have shared with you. 

 The bibliographic styles list can be customized to include only the styles you work with 
using the Customize this list option. 

 Bibliographies can be saved as text files, rich text files (which can be read in almost all 

word processors), or HTML files for the Web. 

After selecting the references, styles, and output file format, you can Save your bibliography to a 

file on your computer, E-mail your bibliography, or Preview and Print your bibliography. 
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6.2 Format Paper (Optional) 

EndNote Web can be used to format citations and bibliographies in any word processor that can 

create a rich text format (RTF) file or with Open Office.  To prepare a document for 

formatting— 

 For each citation in the paper, insert the author’s last name and the year in a set of curly 
brackets in this format: {Smith, 1980}. 

 For grouped citations, insert the citations in a set of curly brackets with semicolons 

between them, in this format: {Smith, 1980; Jones, 1990}. 

 If there may be more than one citation in the library with the same author and year, add a 
portion of the title to the citation: {Smith, 1980, dinosaurs’ extinction} 

 Add any line spacing to the end of the document and a bibliographic title. 

 Save the document as an Open Office (.ODT) document if using Open Office, or as a rich 
text format (RTF) document if using any other word processor. 

 Close the document. 

After preparing the document, select the Format Paper option on the Format tab in EndNote 

Web. 

 Select the document you prepared and saved using the Browse button. 

 Select the bibliographic style from the drop-down list. 

 Click on the Format button to format the paper. 

EndNote Web will create a copy of the document with formatted citations and bibliography.  

By default, it will assign a name to the new document by combining the old name and the name 

of the bibliographic style that was selected for the document.  This new document can now be 

worked with as you would any other word-processing document. 

    

    

    

6.3 Export References (Optional) 

This feature works much like the Bibliography feature.  You can export all the references in 

your library, your Quick List, the references in a specific group, or references in a group 

someone has shared with you.  The main differences between this and Bibliography are that— 

 References exported using Export References will always be saved as plain text files 
because they are meant to be imported into other database or bibliographic software 

programs. 

 The bibliographic styles available here are either delimited or tagged and are designed to 
be imported into other programs. 
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6.4 Cite While You Write Plug-In 

Selecting the Cite While You Write Plug-In option on the Format tab allows you to download 

and install the Cite While You Write (CYWY) plug-in for Microsoft Word.  You do not need to 

install the plug-in if you are using EndNote because EndNote includes CWYW plug-ins for both 

EndNote desktop and Web. 

    

    

7 Quick Search 

The Quick Search feature in EndNote Web is very similar to that of many online database search 

engines.  It will search all fields in the library, and you can search the entire library or just one 

group within the library.  Search terms can be combined or limited as shown in the examples 

below. 

 dinosaur extinction:  Enter multiple words to search for all records containing any of 

those words.  This search would find any record containing either dinosaur OR 

extinction. 

 “dinosaur extinction”:  Enter a phrase in double quotation marks to find records 
containing that phrase.  This search would find only records containing the phrase 

dinosaur extinction. 

 dinosaur +extinction:  Place a plus sign (+) in front of any word that must be present in 
the records found.  This search would find only records containing dinosaur AND 

extinction.  The words would not need to be in the same field, but both would have to be 

present in the record. 

 dinosaur -extinction:  Place a minus sign (-) before any word that must not be present in 

the records found.  This search would find records that contained dinosaur but did not 

contain extinction.  Note that the minus sign can only be used in combination with 

another search term, so you could not enter –extinction alone, for example. 

    

    

8 Cite While You Write (CWYW) 

The EndNote Web Cite While You Write commands will display a menu and toolbar if used in 

Word 2003, 2008, or 2011, and a tab on the Word ribbon if used with Word 2007 or 2010.  

These commands will allow you to search your EndNote Web library for references, insert those 

references into your Word documents, and instantly format the citations and bibliography 

according to the bibliographic style of your choice. 
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The toolbar as it will appear in Word 2003, 2008, 2011 

and the EndNote Web tab for the Word 2007, 2010 ribbon. 

Word 2003, 

2008, 2011 
 

Word 2007, 

2010 

 

Shown below are the buttons for the Cite While You Write commands and short descriptions of 

their functions.  Please note that I have added circles and arrows to some graphics to point out 

exactly where to click on some buttons that have multiple options on drop-down lists.  If you 

are looking at a color version of this outline, you will see them in bright red (versus the darker 

red that is part of the original graphics). 

8.1   Find Citation 

This command opens a search window where you can enter text that is in any field of the 

reference you wish to find.  You can then select references from a list of those that contain your 

search terms and insert them into your paper. _________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

8.2   Go to EndNote Web 

This command will take you to your EndNote Web library. ______________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

8.3   Format Bibliography 

This command will allow you to change the EndNote Web style used for your document.  It 

will also let you make other changes to the layout of your bibliography, such as adding titles and 

changing the line spacing.  (In Word 2007 or 2010, if you wish to change just the style, you can 

do that using the drop down styles list.  If you wish to update your citations and bibliography, 

you can do just that using the “Update Citations and Bibliography” command.  If you wish to 

do both of these, as well as change line spacing, add titles, and access other formatting options, 

click on the small arrow at the bottom right of this button (the one the larger arrow is pointing at) 

to bring up the full Format Bibliography window.) _____________________________________ 

______________________________________________________________________________ 
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______________________________________________________________________________ 

8.4   Edit Citation(s) 

This command must be used to make changes inside a citation, such as adding page numbers or 

removing author names from author-date citations. _____________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

8.5   Unformat Citation(s)/ 
 Convert to Unformatted Citations (Word 2007, 2010) 

This command will remove the formatted bibliography and citations and replace all citations 

with plain-text placeholders that EndNote Web can match to library records to create formatted 

citations.  This command is commonly used when moving documents between word-processing 

programs. _____________________________________________________________________ 

    

______________________________________________________________________________ 

8.6   Remove Field Codes/ 
    Convert to Plain Text (Word 2007, 2010) 

This command will create a second copy of the document with all EndNote Web field coding 

removed (you can generally recognize field codes such as formatted EndNote Web citations by 

their turning grey when you select them in Word).  It is used when sending documents to a 

publisher because the field coding used for EndNote Web citations can sometimes cause 

problems for publishers’ page layout programs.  Please note that this command does not create 

a .TXT plain text file; it creates a Microsoft Word document with the EndNote Web field codes 

removed. ______________________________________________________________________ 

    

______________________________________________________________________________ 

8.7   Export Traveling Library 

EndNote Web creates a hidden “traveling” library containing only the references used in each 

paper.  This traveling library is part of the coded information contained in each citation.  Use 

this command to export the references in this traveling library to your EndNote Web library. 

______________________________________________________________________________ 

______________________________________________________________________________ 



August 14, 2012 Endnote Web.Docx Page 14 of 14 

 © Thomson Reuters, 2012 

8.8   Cite While You Write Preferences 

Use this command to set preferences for EndNote Web’s Cite While You Write settings for 

future documents, and to switch between using EndNote or EndNote Web in Word. 

______________________________________________________________________________ 

______________________________________________________________________________ 

8.9   Help 

This command will let you access the help files for EndNote Web. ________________________ 

______________________________________________________________________________ 


